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3.1	 MS WORD

 Microsoft Word (MS Word) is one of the 
most famous word-processing software. It 
was rst released and made public in early 
1980s by Microsoft. It allows its user to type 
text and manipulate it. MS Word rst 
introduced the concept of WYSIWYG (What 
You See Is What You Get) by introducing text 
formatting and document preview exactly as 
we would get it on a paper. It has advanced 
features like tables, images, advanced 
formatting and reviewing that give its users 
the ability to customize their documents as 
required. Even most of this book has been 
written, edited and formatted on MS Word. Latest versions of MS Word 
come as a part of Microsoft Ofce Suite (which includes other software as 
well like MS Excel and MS PowerPoint). MS Word is still most widely used 
word-processing software in the world. We will be using MS Word 2010 
version in this chapter.

3.1.1 Page Layout Tab

 The Page Layout Tab allows user to control the look and feel of his  
or her document. User can set margins, apply themes, control page 
orientation and size, add sections and line breaks, display line numbers, 
and set paragraph indentation and lines. The Page Layout tab has ve 
groups of related commands namely Themes, Page Setup, Page 
Background, Paragraph and Arrange.

(i) Themes Group

 A theme is a predened set of formatting, colors 
and settings that changes the overall design and look of 
the entire document. Applying themes to our work gives it 
a professional look. There are different themes available 
relevant to the type of document being composed.

(ii)  Page Setup Group

 Page Setup settings help us set 
the page layout properties such as 
margins, orientation and size. The 
settings in this section are often applied 
throughout the document.

Figure 3.1

MS Word 2010

Figure 3.2 Page Layout tab

Margins (HOTKEY: ALT+P+M)

A margin is the area or space between the main content of 
a page and the page edges. This button is used to change 
the margins of the entire document or selected section.

Orientation (HOTKEY: ALT+P+O)

Page orientation or print orientation is the placement of 
contents on a page. This button sets the contents of the 
page or section in portrait (Vertical) or landscape 
(Horizontal) layouts.

Size (HOTKEY: ALT+P+S+Z)

The size button is used to choose the size of the paper for 
current section or entire document.

Columns (HOTKEY: ALT+P+J)

This button is used to split the text into two or more 
vertical columns.

Breaks (HOTKEY: ALT+P+B)

Breaks button is used to insert page, section or column 
breaks in the document.

Line Numbers (HOTKEY: ALT+P+L+N)

This button is used to add line numbers on the left side of 
each line of the document.

Hyphenation (HOTKEY: ALT+P+H)

This button is used to specify how hyphenation in a 
document should be applied.

3.1

Ÿ Demonstrate Page Layout Tab of MS Word
Ÿ Identify the different groups of Page Layout Tab
Ÿ Apply different features available in groups of Page 

Layout Tab
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(iii)  Page Background Group

 These settings are used mostly for special 
documents such as certicates, invitations, 
brochures, essays, etc. It consists of 3 buttons 
namely, Watermark, Page Color and Page Borders.

(iv) Paragraph Group

 The Paragraph Group is 
where we can modify all the settings 
of the paragraphs that appear in 
our document. This allows us to set 
a few basic paragraph styles and 
also adjust the indents and 
spacings.

(v) Arrange Group

 The buttons in Arrange Group 
help the users to quickly arrange 
graphical and other elements of the 
document in relation to the main 
textual content.

Space Before (HOTKEY: ALT+P+S+B)

Space Before is used to indicate how much space 
(in points) is added before the selected 
paragraph.

Space After (HOTKEY: ALT+P+S+A)

Space After is used to indicate how much space 
(in points) is added after the selected paragraph.

Watermark (HOTKEY: ALT+P+P+W)

A watermark is a faded background image that displays 
behind the text in a document. This button is used to 
insert logos, images or text behind the contents of a page.

Page Color (HOTKEY: ALT+P+P+C)

This button is used when user wants to apply a color for 
the background of the page.

Page Border (HOTKEY: ALT+P+P+B)

Page Border button is used to put a border around         
the page.

Indent Left (HOTKEY: ALT+P+I+L)

Indent Left is used to dene amount of blank 
space (in centimeters) used to separate a 
paragraph from left margin.

Indent Right (HOTKEY: ALT+P+I+R)

Indent Right is used to dene amount of blank 
space (in centimeters) used to separate a 
paragraph from right margin.

Position (HOTKEY: ALT+P+P+O)

Position is used to place an object (picture or shape)  on  
the  page  wherever  you want.

Wrap Text (HOTKEY: ALT+P+T+W)

Text wrapping is used to arrange the text around an object 
like an image.

Bring Forward (HOTKEY: ALT+P+A+F)

Brings a selected object in front of all other objects.

Send Backward (HOTKEY: ALT+P+A+E)

Sends a selected object behind all other objects.

Selection Pane (HOTKEY: ALT+P+A+P)

Selection Pane is used to select, show, hide and change 
the order of objects in the document.

Align (HOTKEY: ALT+P+A+A)

Align is used to place objects like pictures, shapes, icons, 
etc. in alignment with margins, edge, or relative to another 
object in the document.
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Teacher
Note

Teachers are required to demonstrate the installation of 
multiple languages like Urdu and Sindhi in Microsoft 
Windows. They can do so by adding languages from the 
Regional Settings of Windows Control Panel. Installation 
of these languages also installs their keyboard layouts 
and enables the ability to type text in those languages.

3.1.2  Table of Contents (ToC)

 A Table of Contents (ToC) is 
an organized listing of the sections, 
groups and headings of content in 
a document and identied by page 
numbers where they are placed. It 
provides an overview of the 
document and allows readers to go 
directly to specic section or 
content in the document. ToC 
usually appears after the Title Page 
in a document. MS Word 2010 
provides an advanced feature for 
automatically creating a ToC. A 
user can create an Automatic or a 
Manual table of contents in a 
document.

 To create a Table of Contents in MS Word document, go to the 
References Tab where Table of Contents button appears as the rst option 
of that tab. MS Word provides several options of creating a ToC that 
include Automatic Table creation, Manual Table creation or the user can 
even create a Customized Table of Contents based on the requirements of 
the document.

(i) Automatic Table

 Automatic Table creates a Table of Contents automatically based on 
the content used as Heading presets of MS Word. Based on the type of 

Heading, Automatic Table of Contents will create the appropriate levels 
and show page numbers where those Headings are placed. The only 
difference between Automatic Table 1 and Automatic Table 2 is the title of 
the table that is “Contents” or “Table of Contents”.

(ii)  Manual Table

 Choosing Manual Table from the Table of Contents menu will create 
a template of a generic table of contents. This table will need to be edited 
and dened manually by providing all the headings, sub-headings and 
page numbers. To extend the table, simply copy and paste the template 
lines and edit them to preserve proper formatting.

3.1.3  Typing in Urdu and Sindhi Languages

 MS Word 2010 helps in writing letters, applications, CVs, question 
papers and books in default language set by Microsoft Windows (that is 
usually English). MS Word 2010 also supports typing text in various other 
languages like Urdu and Sindhi. To be able to write in other languages, the 
keyboards for those languages have to be installed in Microsoft Windows. 
MS Word also supports changing and setting its default language. To 
change the default language, go to the File menu and select Options. From 
the Word Options dialog box, select Language tab. Now choose one of the 
available languages as the default language for MS Word 2010.

Group (HOTKEY: ALT+P+A+G)

Group is used to combine two or more objects together so 
that they can be treated as a single object.

Rotate (HOTKEY: ALT+P+A+Y)

Rotate is used to rotate or ip the selected object.

Ÿ Insert manual and automatic table of contents in a 
document.

Ÿ Compose in Urdu and Sindhi languages in MS Word.

SLOs
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Urdu Keyboard Layout

Sindhi Keyboard Layout

3.2 MS EXCEL 2010

 Microsoft Excel (MS Excel) is a software that uses spreadsheet 
system to organize, display, format and calculate data using advanced 
features and formulas. MS Excel is a part of Microsoft Ofce Suite and 
integrates with other applications in the Ofce Suite. MS Excel offers 
advanced features to perform calculations, visualize data in graphs and 
create pivot tables. It efciently makes use of spreadsheets to organize, 
analyze and store data in tabular and graphical forms. It is the most 
widely used spreadsheet system and has a high demand in many 
organizations for keeping records of data and presenting them as tables 
and graphs.

3.2.1 MS Excel User Interface
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3.2.2  Sorting

 Sorting is the process of rearranging or reordering data based on 
different criteria like size, quality, value and quantity. MS Excel has the 
ability to sort data according to the needs of the user. To help better 
understand this concept, take or create a list of products with their unit 
prices and quantities as shown below.

 The objective is to 
sort this list of products 
with prices and quantities, 
in alphabetical order based 
on  the  names  o f  the 
products. To achieve this, 
rst select all the rows and 
columns which make up 
this product list then go to 
the Data tab and select the 
Sort option.

 In the Sort dialog 
box, choose Product from 
the Sort by dropdown list 
and make sure that in the 
Order dropdown list, A to Z 
is selected.

 Your data will be 
rearranged and sorted 
alphabetically based on the 
values in Product column 
and their respective prices 
and quantities will also be 
rearranged as sorted data 
as shown in the gure here. This data can also be sorted in terms of unit 
price and quantity.

3.2.3 Formulas

 MS Excel 2010 allows its user to perform numerous calculations on  
data. Common calculations include addition, subtraction, multiplication 
and division. Comparison of two numbers and nding their average is also 

possible. Formulas tell MS Excel what calculation needs to be performed 
on the data. Formulas always start with an equal sign (=). They are dened 
in the Formula Bar.
 To understand this concept, take an example of two numbers, 
which are 220 and 87, placed in columns A2 and B2, respectively. The 
objective is to add these two numbers using MS Excel formula. To achieve 
this, follow these steps:
 

1. Select cell C2.
2. Type = (equal sign).
3. Select cell A2 in the worksheet by 

using the mouse or the keyboard. 
This action places the cel l 
reference A2 in the formula of 
selected cell.

4. Type +.
5. Select cell B2 in the worksheet by 

using the mouse or the keyboard 
to put that cell's reference in the 
formula of selected cell.

6. Press Enter.
7. The answer (307) will be calculated by MS Excel and displayed in 

the selected cell (C2) where the addition formula was composed. 
Likewise subtraction, multiplication, division and other 
mathematical functions can be applied.

3.2.4 Charts

 Charts are also known as graphs. They include diagrams and 
tables. Charts feature in MS Excel allows the users to present a set of data 
visually. A huge set of data may not succeed in presenting its meaning to 
the reader whereas visual information helps better understand those data 
values at a glance. To understand this concept, take an example of the 
average monthly temperature for Larkana in 2018 as shown below:

oJanuary 23 C
o

February 26 C
o

March 32 C
oApril  38 C
oMay  43 C
o

June  44 C

oJuly  41 C
o

August  39 C
o

September 39 C
oOctober 36 C
oNovember 31 C
o

December 24 C
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and their respective prices 
and quantities will also be 
rearranged as sorted data 
as shown in the gure here. This data can also be sorted in terms of unit 
price and quantity.

3.2.3 Formulas

 MS Excel 2010 allows its user to perform numerous calculations on  
data. Common calculations include addition, subtraction, multiplication 
and division. Comparison of two numbers and nding their average is also 

possible. Formulas tell MS Excel what calculation needs to be performed 
on the data. Formulas always start with an equal sign (=). They are dened 
in the Formula Bar.
 To understand this concept, take an example of two numbers, 
which are 220 and 87, placed in columns A2 and B2, respectively. The 
objective is to add these two numbers using MS Excel formula. To achieve 
this, follow these steps:
 

1. Select cell C2.
2. Type = (equal sign).
3. Select cell A2 in the worksheet by 

using the mouse or the keyboard. 
This action places the cel l 
reference A2 in the formula of 
selected cell.

4. Type +.
5. Select cell B2 in the worksheet by 

using the mouse or the keyboard 
to put that cell's reference in the 
formula of selected cell.

6. Press Enter.
7. The answer (307) will be calculated by MS Excel and displayed in 

the selected cell (C2) where the addition formula was composed. 
Likewise subtraction, multiplication, division and other 
mathematical functions can be applied.

3.2.4 Charts

 Charts are also known as graphs. They include diagrams and 
tables. Charts feature in MS Excel allows the users to present a set of data 
visually. A huge set of data may not succeed in presenting its meaning to 
the reader whereas visual information helps better understand those data 
values at a glance. To understand this concept, take an example of the 
average monthly temperature for Larkana in 2018 as shown below:

oJanuary 23 C
o

February 26 C
o

March 32 C
oApril  38 C
oMay  43 C
o

June  44 C

oJuly  41 C
o

August  39 C
o

September 39 C
oOctober 36 C
oNovember 31 C
o

December 24 C
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 The temperature table contains data in a form which is not very 
helpful for every user to understand. If the same data is converted into a 
graph or chart, the user would be better able to reach a conclusion. From 
the bar chart, we can easily derive the hottest and the coldest months and 
compare them with each other.

 The same data, if displayed as a graph or chart, will give more 
meaning and a user can easily derive an understanding of such values at a 
glance as seen in the below gures.

 Making this chart is very easy . All we need to do is to select the table 
and click at chart button. 
 There are many types of Charts. Four most common types of chart 
used are: Bar Charts, Column Charts, Line Charts and Pie Charts.

 

Ÿ MS Word is widely used word processing software in the world.

Ÿ The Page Layout Tab has ve groups of related commands namely: 
Themes, Page Setup, Page Background, Paragraph and Arrange.

Ÿ Themes Group is a predened set of formatting, colors and settings that 
changes the overall design and look of the entire document.

Ÿ Page Setup settings help us set the page layout properties such as 
margins, orientation and size.

Ÿ Page Background Group consists of 3 buttons namely, Watermark, 
Page Color and Page Borders.

Ÿ The Paragraph Group allows you to set a few basic paragraph styles 
and also adjust the indents and spacing.

Ÿ Arrange Group helps the users to quickly arrange graphical and other 
elements of the document in relation to the main textual content.

Ÿ A Table of Contents (ToC) is an organized listing of the sections, groups 
and headings of content in a document, identied by page numbers 
where they are placed

Ÿ Typing in Urdu and Sindhi Languages: Change the default language, go 
to the File menu and select Options. From the Word Options dialog box, 
select Language tab. 

Ÿ Microsoft Excel is a software that uses spreadsheet system to organize, 
display, format and calculate data using advanced features and 
formulas.

Ÿ Sorting is the process of rearranging or reordering data based on 
different criteria like size, quality, value and quantity.

Ÿ Formulas help user to perform different types of calculation easily.

Ÿ MS Excel 2010 allows its user to perform numerous calculations on its 
data

Ÿ Charts are also known as graphs. They are used to show data 
graphically. 

Ÿ There are many types of Charts. Four most common types of chart used 
are Bar Charts, Column Charts, Line Charts and Pie Charts.

SUMMARY

Annual Temperature of Larkana (Line Chart)
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Annual Temperature of Larkana (Bar Chart)
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Annual Temperature of Larkana (Bar Chart)
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A.  Choose the right answer:

1. Which chart will be suitable to show the share of three partners in a 
business?

2. The software that is used for accounting purpose is:
a) MS Word    b) MS  Excel
c) MS  Power point   d) MS  Access

3. The software that is used to format a document is:
a) MS Word    b) MS  Excel
c) MS  Power point   d) MS  Access

4. The special character that initiates the formula mode in a cell is:
a) /     b) =
c) -     d) *

5. The function which is used to re-arrange data according to specic 
criteria is called:
a) Filtering    b) Sorting
c) Organizing    d) Grouping

6. If we want to change the overall design of a word document, we should 
use:
a) themes    b) page layout
c) watermark    d) margins

7. The correct formula to calculate the total in the given table is:

a) = B2 + C2 + D2+ E2    b) = B2 + E2   
c) = sum (B2 to E2)     d) = sum (B2 from E2)

8. The correct formula to calculate the percentage in the given table is:

a) =B2 + C2 + D2+ E2  / 400 * 100
b) =B2 + C2 + D2+ E2   * 100
c) =(B2 + C2 + D2+ E2)  / 400 * 100
d) =(B2 + C2 + D2+ E2)  /  100  * 400

9. Charts are basically used to 
a) design tables
b) organize data in tables
c) Sort data in different columns
d) show the quantities and their relationships graphically

10. To apply the table of contents automatically, the most important task 
is to properly dene the
a) levels of heading   b) page numbering
c) page layout    d) themes 

B.  Respond the following:

1. What is a word processor? Write any three applications of a word 
processor.

2. Discuss the Margins and Paper Size options in the Page Setup group.
3. Name and describe two options in Orientation.
4. How can we apply Margins in a document?
5. Describe the different types of breaks in MS Word.
6. Differentiate “Bring Forward” and “Send Backward” options in the 

Arrange group with example.

EXERCISE

b)  

c)  d)  

a)  
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7. Explain the “Columns” option in the Page Setup group.
8. List and dene Position and Wrap Text option in Arrange Group.
9. In what way does a ToC help book reader?
10. Write steps that will multiply 37 by 15 using the formula bar in MS 

Excel.
11. Why do we use Watermark in a document? Give some examples of 

Watermarks.
12. List four uses of spreadsheets in business.

C.  Match the columns:

1. Compose a document in MS Word and apply Watermark, Page Color 
and Page Border.

2. Apply different options of Margins, Orientation, Size and Columns in a 
document. 

3. Add a) 15 Names and b) 15 Marks Obtained in two columns and apply 
different sorting options in MS Excel.

A B CS.NO. S.NO.

(i) (a)Wrap Text documentation

(iii) (c)Page Setup Group sets Show data graphically

(iv) (d)Excel is used to
is created based on
heading

(v) (e)Charts
margins, orientation
and size

(vi) (f)Ms Word is widely used
for

organize, display, format 
and calculate data

(ii) (b)Automatic Table
of Contents

allows to arrange text
around an image

ACTIVITIES
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�ئھ�ن ��ئب� �ئئ���� ����ئ��� �� �ئم ��ڳ �ئن د��ئ 
۾ �� وڏ��ن �ب����ن �� ���� ���ن.

�� �� ا������ �� ا���� ڏاڍي ��� �� و���ي ��ھ� 
�ئن آن �ئ� و���� ا������ ۽ �� �� ��ڻ آ�ئن �� 

و���و.

��� �� ا������ ڊ��ائ� �ئن ���ل �ئئ�� ���ئم �ھ�ڳ وارو 
و�� ��ئم ��� �ڳ��و ���� �با ����� �ھڻ� ��ي 

وارن ��ئ�� ۾ و�ھ� ائ�� ����ي ���ا ��ئ� �� �ئڻ 
ا�� ����د ���. ور��ئ� ر�ئ��� �� ذر��� را�� رو�� 

��ي ���ب�.

���ن ����� �ئن ����� ۾ بھ��ي ا���ي ��ھ� �ئن 
ا������ آف ���� (آئ� او ��) �� ���ان ۾ وڏي ���� 

�� ���� آ��.

�ئئ���� ا�ڳ �ئن ��ھ ا��� �ئ� و�� �� �� 
روب����، ا������ آف ����، ��ا����رٽ، �ا ۽ 
ا��ئ�� �� �� ����ئڪ ��ب� ۾ ����� �� ا����ئل 

���� �� و���و.  

� ���� � �� ��� ��� � �م �� � �رى د� � ��ى ��

��ں �� �۔
��� � � � � ا�� � ا� � ز��دہ � � �� � � � آن �� �

� � �
� و��� ا��� اور �� �م ��� آ�ن � �� �۔�

� �� � � دو�ے ا�� ڈ�ا� � �ل � �م �� � و� � ��� �

� � � �� دوردراز ��ں � اس �ح آ�� � � � 
�� ���� � � ذر� � � �� � � و�ں ��د �ں۔ ور�� ر

�۔

�ے �ں � � � �ى � (آ� او �) � �ان � 
� �
����ى ��� � �� �۔� � �� ��� � ، � �� � � آ� � ا� � � رو��، ا�� آف 

��
�ا�رٹ، � اور ا���ں � � ���ك �ں � �ں � 

ا�ل � ��۔

4. Type the following text in MS  Word using Urdu or Sindhi language 
facility. 

5. Using the following pie chart, prepare an excel sheet to calculate: 

(a) How many runs came for 

ones, twos, fours and sixes?

(b) The strike rate of the player.

(c) Using the scores prepare a pie 

chart to show the share of 

ones, twos, three, fours and 

sixes in score of 149.
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6. Create a newsletter in MS Word using your knowledge. The newsletter is 
required to have a header, three columns, and some graphics with text 
wrapped around them. The nal result may look like:

7. Create a spreadsheet of employees' payroll in MS Excel. The 
spreadsheet should meet the following requirements:
· The columns should include Emp ID, Emp Name, Dept, Basic Pay, 

Medical Allowance, Conveyance Allowance, House Rent, Gross 
Salary, Income Tax and Net Salary.

· As User enters Basic Pay, rest of the columns should be calculated 
automatically.

· The calculation should be done on following method:

Columns for Calculation

Medical Allowance (MA)

Conveyance Allowance (CA)

House Rent (HR)

Gross Salary

Income Tax

Net Salary  Amount after deduction of Income Tax

Criterion

15% of Basic Salary

22.5% of Basic Salary

40% of Basic Salary

Sum of Basic Pay, MA, CA, HR

7.5% of Gross Salary

You will find the header in the
view Menu. Click on View 
and drag to Header and
Footer. It will instantly put you
in the header or you can scroll
to the Footer. You can use all
the standard word formatting
option and also insert graphics
and put a boarder around 
the text. 

You can add Columns
easily to your newsletter.
You will find this option

Here are some tips on
creating a newsletter.

A side from basic Word 
Skills there are a few 
things you need to 
known. they are: using 
headers, using columns,
inserting graphics and 
putting borders around 
text and graphics.

This tutorial is based on
using the Menus, not the
floating palettes. If you are
more comfortable with the
floating palettes, by all means 
use them.

Creating a
Newsletter

The Header

Columns

in the Format Menu.

 1. Click on Format and 
  drag to Columns.
 2. Choose one of the
  presets (One, Two, 
  Three, Left, Right).
 3. Click on the Line
  Between option if you
  want a line between the 
  columns.

 4. Experiment with other 

  options.

You can apply a boarder to 
selected text and/or the whole 
Page. You can also apply some 
Shading or color behind 
text.

To apply a boarder to whole 

document:
 1. Click on Format drag
  to boarder and shading.
 2. Click on the page
  Boarder Tab
 3. Choose your setting.
  style, Color, Width etc.

 4. Click OK.

 5. Experiment with other

  options.

 1. Hi-light the text you
  want the border around.
 2. Click on Format, drag
  to Boarders and 
  Shading.

 3. Click on the Borders
  Tab
 4. Choose your Setting,
  Style, Color, Width etc.
 5. Click OK.
 6. Experiment with other
  options.

 1. Insert the picture
 2. Turn on the text wrap
 3. Click on the picture
  (you should see
  handles)
 4. Click on the Format
  Menu . Drag to
  Picture or Object
 5. Click on the colors
  and Lines tab .
 6. Select a Color,
  Dashed, Size and 
  Weight.
 7. Experiment with other
  options.

Applying a
Border
to Text

Applying a
Border

to a Picture

Borders and
Shading
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6. Create a newsletter in MS Word using your knowledge. The newsletter is 
required to have a header, three columns, and some graphics with text 
wrapped around them. The nal result may look like:

7. Create a spreadsheet of employees' payroll in MS Excel. The 
spreadsheet should meet the following requirements:
· The columns should include Emp ID, Emp Name, Dept, Basic Pay, 

Medical Allowance, Conveyance Allowance, House Rent, Gross 
Salary, Income Tax and Net Salary.

· As User enters Basic Pay, rest of the columns should be calculated 
automatically.

· The calculation should be done on following method:

Columns for Calculation

Medical Allowance (MA)

Conveyance Allowance (CA)

House Rent (HR)

Gross Salary

Income Tax

Net Salary  Amount after deduction of Income Tax

Criterion

15% of Basic Salary

22.5% of Basic Salary

40% of Basic Salary

Sum of Basic Pay, MA, CA, HR

7.5% of Gross Salary

You will find the header in the
view Menu. Click on View 
and drag to Header and
Footer. It will instantly put you
in the header or you can scroll
to the Footer. You can use all
the standard word formatting
option and also insert graphics
and put a boarder around 
the text. 

You can add Columns
easily to your newsletter.
You will find this option

Here are some tips on
creating a newsletter.

A side from basic Word 
Skills there are a few 
things you need to 
known. they are: using 
headers, using columns,
inserting graphics and 
putting borders around 
text and graphics.

This tutorial is based on
using the Menus, not the
floating palettes. If you are
more comfortable with the
floating palettes, by all means 
use them.

Creating a
Newsletter

The Header

Columns

in the Format Menu.

 1. Click on Format and 
  drag to Columns.
 2. Choose one of the
  presets (One, Two, 
  Three, Left, Right).
 3. Click on the Line
  Between option if you
  want a line between the 
  columns.

 4. Experiment with other 

  options.

You can apply a boarder to 
selected text and/or the whole 
Page. You can also apply some 
Shading or color behind 
text.

To apply a boarder to whole 

document:
 1. Click on Format drag
  to boarder and shading.
 2. Click on the page
  Boarder Tab
 3. Choose your setting.
  style, Color, Width etc.

 4. Click OK.

 5. Experiment with other

  options.

 1. Hi-light the text you
  want the border around.
 2. Click on Format, drag
  to Boarders and 
  Shading.

 3. Click on the Borders
  Tab
 4. Choose your Setting,
  Style, Color, Width etc.
 5. Click OK.
 6. Experiment with other
  options.

 1. Insert the picture
 2. Turn on the text wrap
 3. Click on the picture
  (you should see
  handles)
 4. Click on the Format
  Menu . Drag to
  Picture or Object
 5. Click on the colors
  and Lines tab .
 6. Select a Color,
  Dashed, Size and 
  Weight.
 7. Experiment with other
  options.
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